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Welcome to the latest edition of my monthly Final Cut Studio newsletter for February and March, 2008.

The goal of this newsletter is to provide information helpful to the professional user of 
Final Cut Pro. This newsletter publishes each month. Past issues are not archived. 
However, key articles are posted on my website for your reference. All software 
references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find 
over 250 tips and tutorials to help you get the most out of Final Cut!
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Welcome!

Well, to paraphrase Garrison Keillor, "it's been a busy week in Lake Woebegon."

I'm finally back home after a very interesting seminar tour of the 
UK, including stops at the Video Forum / Broadcast Live 08 
trade show and a special event hosted by the BBC for college 
students in Glasgow, Scotland. I'll have more on this in a minute.

Later this month, it's off to St. Louis to teach an advanced Final Cut Pro class.

It's also been great fun settling into the host chair for Digital Production BuZZ. Talking to industry 
leaders, editors, and producers each week has helped me get a much clearer picture of what's 
happening in our industry. A picture which I try to share with you every week on the BuZZ. 

Plus, we are already gearing up to attend the FCPUG NAB 08 SuperMeet. I hope to see many of you 
there!

[ Go to Top. ] 

UK Seminar Tour Trip Report

I had a great time during February meeting with lots of different editors during my United Kingdom 
PowerUP with Final Cut seminar tour. And I want to thank everyone that attended for taking the time to 
share their ideas and interest in Final Cut Studio.

Also, during the trip I made two key discoveries that I think are worth sharing with you.

�●     First, high-definition does not have anywhere near the interest or penetration in the UK as it 
does in the US. In fact, in talking with editors, producers, and management, I've been surprised 
at how little interest there is in HD -- mainly because there is a very, very small market for it.

We've been following this issue during the last month in a series of interviews aired as 
part of the Digital Production BuZZ podcast. (Which, by the way, is a great place to 
keep up on what's happening in the broader world of production and post-production.)

�●     Second, is the increasing use of Final Cut in all stages of video production -- from hobbyists to 
network broadcasting. With the exception of BBC-Scotland, everywhere I looked Final Cut 
Studio use was increasing. 

I think this bodes well for all of us. The greater the installed base of Final Cut users, the greater the 
interest from both developers and users in finding ways to make the most of the program.

[ Go to Top. ] 

Notes on Blu-Ray DVD Costs and Competition
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In January, the battle between HD-DVD and Blu-Ray was finally 
decided in favor of Blu-Ray. We've been covering this in detail 
for the last couple of months on the BuZZ with regular reports 
from both Philip Hodgetts and Bruce Nazarian.

However, from the point of view of smaller producers, the best format may not have won. Well, more 
specifically, the least expensive format did not win.

I recently published a article on my website that's relevant to this point, and then after that you'll find 
an update.

In a recent conversation with Bruce Nazarian, president of the DVD Association, during 
The BuZZ podcast (www.digitalproductionbuzz.com), we were discussing the sudden 
shift toward Blu-Ray DVDs. While Blu-Ray may be good for Hollywood, it won't be good 
for small independent producers. This is due to all the hidden fees tacked on to 
replicating a Blu-Ray DVD.

For example, producers of industrial and non-broadcast content are required to pay a 
$2,500 licensing fee to author and distribute Blu-Ray. [This is updated, see below.] 

Then, each producer is required to pay a $3,000 one-time AACS license fee, plus a per-
title fee for EACH replicated Blu-Ray disc. Currently, Sony DADC is quoting that fee at 
$1,585 per title (per complete Blu-ray disc project).

Then there's the per disc replication cost, which varies by quantity, and finally, there's a 
$0.04 per disc fee for AACS and $0.01 per disc if you want SONY DADC to administer 
the payments to AACS on your behalf.

As Bruce indicates, we may be standardizing on Blu-Ray, but the prices won't be cheap.

That article sparked a lot of discussion, especially regarding licensing fees for Blu-Ray. I received 
several emails from readers pointing out that Blu-Ray has a lower-cost licensing program. So, I did 
some more homework and discovered that while that is true, it's only a part of the story.

Here's the update.

Several people have pointed out Blu-Ray's logo licensing program (http://www.blu-
raydisc.info/faq.php) has a reduced fee of either $3,000 or $500, paid annually.

However, Blu-Ray duplication or replication requires using AACS (http://www.aacsla.
com/support/). So, while Blu-Ray costs can be reduced for small runs, AACS fees still 
apply.

Further complicating this issue is a recent research report (http://www.macworld.com/
article/132232/2008/02/bluray.html) from Gartner and iSuppli which indicates that Blu-
Ray may not be successful in the market place, because consumers may choose to 
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download high-definition content from the web.

Additionally, recent conversations with Apple, covered in either the BuZZ or Edit Well, 
have indicated that Apple views digital downloads with much more interest than the 
creation of optical media. 

So, while the format wars between HD-DVD and Blu-Ray are over, Blu-Ray is not yet priced 
attractively for the independent producer. As well, the entire issue may be moot if a viable financial 
mechanism appears that allows the independent producer to make money on downloads. For 
example, currently iTunes is more accessible for the larger studios, not in providing distribution 
opportunities for independents.

Depending how this plays out over the next year, Blu-Ray DVDs may yet become a non-issue.

UPDATE - March 6

Samantha Timmerman writes:

With all the coming changes in the business regarding Blu-Ray, etc, I'm convinced that 
it will, unfortunately, be very difficult for independent, documentary filmmakers to 
distribute and sell anything - as the costs are becomming prohibitive!

This proclivity of making everything licensable instead of buying something outright, is 
frankly, undermining the economy and creativity... but that's another argument and as 
you often say, I digress...

Clay Coleman writes from the UK: 

We had gotten all excited here and were planning on diving in, but now definetly have 
serious second thoughts. Our assumption was that Blu-Ray was basically an upgrade 
from DVD; better quality, a better delivery format, and at 50GB per disc very useful for 
archiving (P2, HDV, Masters backups, Project Files, misc. stuff), and at a cost of simply 
upgrading drives and players while assuming that the cost for blank discs would come 
down substantially over time.

I also think that for medium and smaller producers in the corporate and commercial 
area, the fees and administration work involved is a deal-breaker. For the same 
reasons, I can't see clients (including the big guys) going for it either, certainly not at the 
cost levels you mention.

In the real world, it just doesn't make sense. I've never paid an anual fee for owning a 
DigiBeta machine, or have charged a client 1500 bucks for delivering one DVD. And 
what constitutes "per complete Blu-ray disc project"? What happens with a re-edit of a 
previous job or a new language version? Are those new projects? And who is going to 
keep score? etc. etc. etc. Franz Kafka couldn't have done better as far as creating an 
administrative nightmare is concerned.

Bottom line: IMHO Blu-ray, very unfortunately, is now a dead issue. They potentially had 
a good thing going, even won the war, but screwed up the peace. 

Larry replies: Thanks for your comments. 
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What's The BuZZ?

If you haven't tuned in yet to our podcast, you need to stop by for a visit. The Digital Production BuZZ 
has been providing on-going coverage of the fall-out of the Blu-Ray 
victory, along with fascinating interviews from producers and editors in the 
UK.

Coming up this week on The BuZZ:

�●     Chad Denning with a "cheat sheet" he developed to help avoid 
the pitfalls in HD production.

�●     Alan Slattery, a filmmaker in Ireland, talks about HD, filmmaking 
and the Young Ireland Film Makers association.

�●     Kenn Bell award-winning graphics designer, discusses the shift in music videos from telling a 
story to creating a look. He's also developed a fascinating on-set production workflow that can 
help you with your productions.

The show airs live (mostly because if we didn't have a deadline, the show would never get done) every 
Thursday from 6 - 7 PM PST. Click here to listen.

To find out who's on this week, click here.

To visit the archives, click here.

(By the way, like the proverbial shoemaker who's kids go barefoot, I discovered that 
several of our February shows have significant distortion. It was caused by an audio 
compressor that we weren't monitoring properly. Sigh... I hate when that happens. 
We've since replaced it.)

[ Go to Top. ] 

Technique: Thoughts on Render Files

One of the questions I get asked a lot is how to manage render files in Final Cut Pro.

The answer is that render files are easy to manage if you understand some key concepts.

Note: "render" has a simple definition, even though it has an unpleasant name. "To 
render" means "to calculate." Complex effects need to be calculated before they can be 
played in real-time. It would have been easier for all of us if the programmers had just 
called them "calculated files," but, no, they needed to intimidate us instead.

Here are the basic concepts behind render files: 

1.  Render files are contained in the sequence, not the clip.
2.  There is a maximum of one render frame for every sequence frame
3.  Rendering a nested sequence does not affect the rendering of the clips contained in the 

original sequence.
4.  Changing an effect, transition, or clip visibility instantly deletes all the render frames associated 

with it. (Yes, they remain as part of the Undo queue, but, essentially, when you alter something 
that has render files associated with it, the old render files are gone.)

Render files are exactly the same size and format as your sequence settings -- with one exception. 
With the release of Final Cut Studio 2, and the introduction of the ProRes 422 codec, Apple has added 

http://www.digitalproductionbuzz.com/LiveThisWeek
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the capability of rendering HDV and XDCAM HD/EX video using ProRes, instead of the native format. 
Based on my tests and reading, I think this is a good idea.

First, rendering is about 35% faster when using ProRes rather than the native codec. depending upon 
the speed of your computer and the complexity of your effect. Second, you are creating render files in 
a higher-quality format, which means that there is less image degradation during rendering. 

The only negative to this approach is that ProRes file sizes are four to five times bigger than the native 
codec. The reason for this is that ProRes is much less compressed than either HDV or XDCAM, which 
accounts for it's increased speed and image quality.

When you change the visibility of a track, by toggling one of the green visibility lights, you 
automatically delete all render files associated with any clips on that track. This is because render files 
are tied to the sequence, not the clips. You've just changed the content of the sequence, which affects 
the render files.



A much better approach is to make individual clips invisible by control-clicking a clip and unchecking 
Clip Enable. You will still lose the render files associated with that specific clip, but you won't lose the 
render files for an entire track. (The keyboard shortcut to toggle Clip Enable is Control+B.)

During the course of editing a project you can essentially ignore managing your render files. Final Cut 
handles them automatically. Similar to the video you capture, render files are stored in your scratch 
disks, in a folder named after your current project, in either the Render Files folder or the Audio 
Render Files folder.

When your project is complete, output, signed-off, and paid for, then, you'll need to delete your render 
files to regain disk space. There's never a reason to archive render files, as Final Cut will recalculate 
any missing render files. And, in fact, each version of Final Cut brings improvements in rendering, so 
there's no good reason to retain render files from a project created by an earlier version of Final Cut, 
as the new version will make them look better anyway.

Unlike Media Manager, which should be avoided by any individual with common sense, the Render 
Manager works great. Even better, it's easy to use.

Choose Tools > Render Manager to display the window. Render files are separated as either video 
or audio renders, and stored first by sequence and then by project. Render files are grouped by 
sequence; within Render Manager you can't see individual effects.



To delete a render file, simply click in the delete column and click the OK button at the bottom of the 
window. 

If the render file was created recently, you'll get a warning saying that deleting render files will empty 
the Undo cache. In all cases, deleting render files is not undoable.
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Keeping Up with the Latest News

Thanks to the hard work of Mike Horton, we are publishing a "Latest News" column on our home page. 

If you haven't visited recently, drop by www.larryjordan.biz and 
take a look at the scrolling window on the top left side of the home 
page. This gets updated about once a week.

If you get tired of scrolling, click the Load News in Popup Window link at the bottom to see 
everything all at once.

Thanks, Mike, for making this news possible.
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Technique: Creating Freeze Frames and Exporting Stills from FCP 6.0.2
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With the release of Final Cut Pro version 6.0.2, Apple quietly changed the way it handles exporting still 
images; and, I suspect, also image sequences. 

Almost all video formats use rectangular pixels to create their images (this includes DV-NTSC, DV-
PAL, HDV, DVCPROHD, and XDCAM-HD). However, the computer uses square pixels for all its 
images - both print and web. (For a fuller discussion of this, read this article.)

This means that, prior to 6.0.2, any freeze frames you export from Final Cut need to be altered in 
Photoshop, or another graphic application, to convert them from a rectangular pixel aspect ratio to a 
square pixel aspect ratio. While not hard to do, many new users don't understand pixel aspect ratios, 
so they couldn't figure out why their images looked stretched.

The process of creating freeze frames (or "still frames," both terms are valid) hasn't changed since 
about forever:

�●     In either the Timeline or the Viewer, put the playhead on the frame you want to freeze
�●     Choose Modify > Make Freeze Frame or press Shift+N

The newly-frozen frame appears in the Viewer with a default duration of 10 seconds. (You can change 
this duration in Final Cut Pro > User Preferences > Editing tab -- Still / Freeze duration.)

This newly-created freeze frame is temporary, you either need to edit the Viewer clip back into the 
Timeline, or drag it from the Viewer into the Browser to store it for later. If you load anything into the 
Viewer before editing the freeze frame, the freeze frame will disappear.

So far, no surprises. This works the same as always.

To export a freeze frame also remains the same:

�●     Put either the Timeline or Viewer playhead on the frame you want to export
�●     Choose File > Export > Using QuickTime Conversion
�●     Give the export a name and location.
�●     Change the Format from QuickTime movie to Still image

By default, Final Cut will export the image as a PNG, which is a nice uncompressed file format.

http://www.larryjordan.biz/articles/lj_grfx_look.html


So far, no surprises. This works the same as always.

However, with the release of version 6.0.2, Final Cut now changes the aspect ratio of the clip during 
export. 

In the past, the image would export at the video aspect ratio. DV-NTSC, for example, would export as 
720 x 480. Now, however, Final Cut converts the image from a video aspect ratio to the square pixels 
used by the computer. In other words, the 720 x 480 DV still frame is resized automatically to 640 x 
480.

If your goal is to export a still frame and use it on the web or in print, this aspect ratio conversion is a 
good thing, because the image is ready to go upon export, no resizing is necessary.

If, on the other hand, you are exporting a still to use as a reference - for example, in Photoshop to 
determine the placement of DVD button overlays, this changed aspect ratio makes working with stills 
that are going to be reimported into video a REAL problem.

And there's no way to turn this resizing off. 

DV-NTSC is automatically scaled to 640 x 480. 720p DVCPRO HD is automatically scaled to 1280 x 
720, and 1080i HDV is automatically scaled to 1920 x 1080. None of these images are at their native 
size.

I sent a note to Apple requesting that they give us the option of changing the aspect ratio during 
export. For now, however, you need to know that exporting has changed so you don't get surprised 
when your images come out a different size than you expect.

UPDATE - March 6, 2008

Andy Field writes:

An excellent warning about exporting freeze-frames and the square pixel aspect ratio

However — there’s no solution or “what to do about this” when importing into video.” ...
Is there a fix in Photoshop to re-export out with the proper aspect ratio.



Larry replies: Andy, there's a work-around, but not a fix, as the workaround decreases image quality

With the freeze frame open in Photoshop, and assuming you are working with NTSC DV 4:3:

�●     Select Image > Image size
�●     Turn OFF Constraing proportions.
�●     Resize the image to width: 720, height: 540, dpi: 72.
�●     Save as TIFF
�●     Import into Final Cut. However, there will be a loss in quality and, probably, a gray-scale shift. 

[ Go to Top. ] 

This Month in Edit Well

Edit Well is the rich-media newsletter for Final Cut Studio and designed for intermediate and advanced 
Final Cut editors.

In this month's issue, you'll find:

�●     Audio interviews with Philip Bloom, Tom Meegan and Eric Maierson discussing editing 
XDCAM EX, using Final Cut in live sports broadcasts, and editing documentaries with 
hundreds of elements.

�●     Shane Ross suggesting five ways to better organize your projects.
�●     Ned Soltz surveying the field of Final Cut plug-ins
�●     Noah Kadner writing on how to setup a 24 fps workflow for editing XDCAM HD
�●     Mark Spencer continues his fascinating series on working with 3D in Motion 3
�●     Alexis Van Hurkman is making Color understandable to mere mortals with his series on using 

vignettes in Color.

Click here to view the Table of Contents.

Click here to subscribe.
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Tip: Sharing Motion Projects

Matt Davis sent in the following tip:

When moving a Motion project between computers, you can't simply move the Motion 
project as it won't contain any movies, images, or sounds that you've added to the 
project.

So, to move a Motion project to another machine, choose File > Save As, enter your 
desired name and NOTE the pop-up below, "Collect Media". Usually set to "Off", in this 
case ensure it's set to "Copy to Folder".

http://www.peachpit.com/promotions/promotion.aspx?promo=135721
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Motion will tell you how much space the assets will take up, and place them in a 
subfolder labeled 'Media' in the same location as your Motion project.

This may be quite a large folder!

However, with this folder on the client's system, all you'd need to do is to email the 
Motion project to them so they can review further work on your version of the project. By 
using the same folder on both system, the Motion's links to the media will be maintained.

Don't forget to also send any new or replacement media to the client with instructions to 
place it in their Media folder.

Larry replies: Tom Wolsky reminded me that this process does not handle collecting fonts very well, 
which can provide strange results when you open the project on a different machine. 

[ Go to Top. ] 

More Thoughts on Archiving

After reading my recent thoughts on archiving, Andrew Wilson sent this in:

The main reason I'm writing is that in the middle of all this weighing back and forth, a 
client of mine asked me if I could author a DVD of a video he produced less than 10 
years ago. It was mastered on D2. After about a half hour on the phone, I found a place 
that could make a D2 dub for me. So my point is that it's not just the computer industry 
that has these problems, but I think that it's driven by the computer industry - that 
planned obsolesce, and need to upgrade to something better and faster and not 
compatible with the previous generation. It seems like the older something is, the more 
reliably it will be around for a long time - starting with film (as you pointed out on your 
show) to Betacam to finally HDV which I think is going to die out as a high-def tape-
based format.

But it is true that the computer industry is much quicker to make things better and faster, 
just think, Betacam was around for quite awhile when Syquest drives first came out and 
AVID 9 gig drives were $2000.

Larry replies: Andrew, I agree. It's nice to have the latest and greatest toy, but it is incredibly frustrating 
when you can't access something you created as recently as ten years ago.

I'm hoping that if we keep complaining loud enough, a manufacturer somewhere will figure there's a 
market here and find a way to meet it.
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Creating Credit Scrolls 

Jonathan Pienaar, of Zimbabwe, sent this in:

I agree with you about Final Cut's built-in scrolling title being hopelessly fiddly. For quick 
yet stylish end-rolls I use Boris Title Crawl (Part of the Boris 3D Extras package) - and 
this is how I freeze on a last piece of text:

�●     Park the timeline where you want it to freeze.
�●     Shift-N to grab a freeze frame
�●     Drop the freeze frame onto V2 (or next available video track)
�●     Reload the credit roll into the viewer (double-click the title clip in timeline), 

making sure not to move the timeline cursor
�●     Make a keyframe in the Motion Tab for opacity
�●     Move 1 frame later and set opacity to 0

As a note: if the titles are over a moving background, Shift-N will also grab the 
background and freeze that, which may be undesirable; and loading the title-roll into the 
viewer will result in a freeze-frame of the first page of the roll, for some strange reason. 
The workaround here is to do the title roll and freeze on black first, then add the 
background visuals - the freeze will retain opacity.

It goes without saying that Inscriber's TitleMotion (http://www.broadcast.harris.com/
inscriber/titlemotion/) is a far more integrated tool, and provides a lot more flexibility in 
terms of font colours, etc. The more I get to use it, the more I like it.

Chi-Ho Lee (an Apple Final Cut Studio trainer) writes:

This is in regards to pausing a credit roll in Boris Title Crawl (if I'm reading this 
correctly). There's a "Use Percent Completion" option is the Controls tab. You have to 
turn on this option by checking the box, then you can easily keyframe this option to stop 
a roll wherever you like. It's a little hidden but it's been there since since they've 
packaged Boris with FCP. It's a whole lot easier then making freeze frames and what 
not. 

Larry replies: Jonathan and Chi-Ho, thanks for these larry@larryjordan.biz tips, and the reference to 
TitleMotion.

Just for the record, I'm a huge fan of LiveType for the simplicity of its interface whenever I create 
animated text or title crawls. Here's an article that describes how. 

Another Way to Do a Scrolling Title

Cal Deal sent in his suggestion for a scrolling title:

I tried your technique of using LiveType for scrolling credits, but couldn't get it to work. 

So, am returning to a technique I've used before ... creating a great big jpeg and 
scrolling the picture! I can do it in FCP, or use the program Photo to Movie (which is 
really cool, but limited). The nice thing about Photo to Movie, I'm finding, is that you get 
a good, high quality preview of the scroll and can easily adjust the timing. I suppose you 
can do this elsewhere, but this is very smooth and a lot simpler that dealing with Live 

http://www.broadcast.harris.com/inscriber/titlemotion/
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Type, or so it seems.

I used that rounded Arial font you like, applied an action to make the Levels 16 and 240 
for video, and added a .4 Gaussian Blur. Then I used the motion keyframes in Photo to 
Movie to pan the jpeg, exported a Quicktime video, took the video into Final Cut, 
assigned a "lighten" composite mode, and laid it over a Digital Juice motion 
background. I used a feathered mask to make the scrolling type disappear as it 
approached a headline at the top of the page. It worked!! And the type looked good too. 

In this project — a video for mediation — I am creating the presentation in Keynote, 
panning photos with Photo to Movie, and putting the video from both programs together 
in Final Cut. 

Larry replies: Cal, thanks for sending this in. 

UPDATE - More Ideas - March 6, 2008

Tom Wolsky writes:

As for scrolling text: there isn't a single scrolling text tool on the Mac that I know of that 
works properly for video, with the exception of After Effects, which can be made to do it. 

The fact is all these scrolling text tools can make text speed infinitely variable, which 
seems like a good thing, but not for video. Because of interlacing scrolls can only move 
at specific speeds. 120 pixels/seconds or multiples of that. You can exactly adjust the 
pixel speed in AE, but not in any other application. None of the Apple scrolling text tools 
can be exactly controlled based on speed per pixel per second. Hardware scrollers like 
Chyron had specific speeds. You could pick one you wanted. You couldn't just say 
make it a little faster or make it little slower. The rate moving across the screen had to 
be exact. 

The best solution for video is don't scroll the text. Make separate title cards and put 
them up as quickly as you want. Watch TV shows, except for Access Hollywood at 1200 
pixels/second, most shows use sequential graphics cards not scrolls.

Larry replies: Thanks, everyone, for your comments. 
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Reader Mail

Lots of Questions

Bruce Whealton writes:

My first question deals with compressed and uncompressed digital video. In the Flash 
Video Class on Lynda.com the instructor says that if we are going to use the Flash 
Video Encoder, to not double compress. The Flash Video Encoder will compress the 
video, so we should start with an uncompressed video file. However, it seems to me 
that whenever I use any of the NLE (Video Editors), and I haven’t used every one, it 
seems that every output format is a compressed video format. Even avi is compressed, 
is it not?

Larry replies: Your confusion stems from the fact that "compressed" means multiple things. You don't 
want ot recompress video that has already been compresed for the web. . Another way to think of this 



is that video you can edit is suitable for compression, while video you post to the web is not. 

I use any of the NLE (Video Editors), and I haven’t used every one, it seems that every 
output format is a compressed video format. Even avi is compressed, is it not?

RAIDs are needed for video formats other than DV, HDV, and DVCPRO-50. All three of these have 
low enough data rates that the speed of a RAID is not required. You know you need a RAID when you 
are consistently getting dropped frame errors.

You mention using RAID for editing, playing, etc. higher data rate formats. I haven’t 
used RAID on my system but really haven’t had a problem where my disk drives were 
not fast enough. Perhaps, I have not yet done something that would require a faster 
data rate, or used a format that would require this. Can you elaborate on when I might 
begin to see a need for this faster disk access speed? Does it show up in both playback 
and editing, capturing or when?

DV is a video format with a data rate of 3.75 MB/sec. It can be either NTSC or PAL. In all cases, DV is 
standard definition in size.. SD (Standard Definition) is a class of video formats that include both NTSC 
and PAL. All DV is standard definition. Not all SD is DV. 

Then on the chapter on Data rate you state that DV is 3.75MB/s, followed by SD 
Uncompressed 8-bit at 20.2MB/s. I’m a little confused as to what the differences are. I 
thought DV was both a medium and a SD format. Similarly, how could HDV be slower 
than DV, when HDV is higher definition, correct? You then point out that 1080i 
uncompressed is 160MB/s. I thought HDV was a format that could be progressive or 
interlaced. What exactly are we talking about in reference to HDV and then 1080i 
uncompressed. Is the key difference the uncompressed aspect of things? Does HDV 
denote a specific compressed format?

HDV is the same file size as DV due to EXTREME data compression. Some people feel the data 
compression does not hurt the picture. Others disagree. Violent arguments have erupted over this 
point. Yes, the HDV image size is bigger, but the data file size is the same as DV. HDV is NOT slower, 
nor faster, than DV. Simply that the file sizes are the same.

HD (high-defintion) video encompasses over 120 different file and video formats; of which HDV is 
comprises six. All HDV is HD, not all HD is HDV. HD can be both progressive or interlaced. 720 or 
1080. 24, 25, 29.97, 30, 59.94 or 60 frames per second. It's a mess.

The last question relates to Digibeta. Is that a format still used today? Does it relate 
specifically to a particular medium? Does it relate to how the video is recorded? Are 
there still digital video recorders that use this? Or am I just confused on the topic?

DigiBeta is still used every day in both broadcast and post-production. It is the highest quality SD 
video format with a data rate of about 26.5 MB / second. DigiBeta is always recorded to tape. The 
digital version of DigiBeta is Uncompressed 10-bit NTSC (or PAL) video.

Thanks for writing.
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Thoughts on Integrating HD and SD

Gordon Inglis writes:

We use the XDCAM HD and gather our material at the HQ setting (29.97, 35mbs, 
1080i) but we are outputting DV NTSC. For our purposes scaling in FCP works very 



well with no issues that I can discern and the render time is a lot faster than the painful 
conforming process.

Once you get used to working with HD on an SD timeline and start to exploit the scaling 
ability this offers, it is pretty hard to imagine going back.

My prediction for the future of our industry is that it will become the norm that the 
acquistion of the image will always be of higher resolution than the final output. This is 
where RED is staking out some early territory (maybe). But for an editor the ability to 
scale your images by 100% is invaluable.

In our situation there isn't enough reason to output at HD, and when it finally does 
become worthwhile for us to ouput at HD I know I will want to upgrade my camera to get 
a bigger image to work with in the editing process. 
 
In my opinion, those people that are editing on an HDV timeline but outputting at SD 
when finished are missing out on the real value of shooting in HDV.

Larry replies: Gordon, this is an interesting perspective - especially because your system allows easy 
reframing and stabilization of shots with essentially no loss in image quality. What interests me is that 
you are satisfied with the downscaling in FCP. Other editors would disagree. What this tells me is that 
editors should consider looking at this workflow. If the quality is acceptable, I agree with you, the 
savings in time and greater flexibility make it hard to beat. 

[ Go to Top. ] 

Trying Out 16:9

Skip Hall writes:

I think I'd like to try a project in 16:9 format, since many of my clients have widescreen 
LCDs and such these days. There's no WAY I'm ready to even THINK about going HD, 
but I thought that I might be able to make things look a little better if I could fill a screen 
a bit more. 

Is it an impossible dream with a couple of aging Canons and FCP, or can it be done? If 
so, can the steps be condensed down to less than a dozen, or will more college be 
required? 

Larry replies: Piece of cake. The key is to frame your images during shooting so that you can crop 
about 10% off the top and bottom of the image during editing. Things get MUCH more complex if you 
frame your material during shooting as 4:3, then decide later during editing to make it 16:9.

Assuming your images are framed properly, the easiest way to convert them from 4:3 into 16:9 is as 
follows:

1. When editing is complete, create a new sequence

2. Double-click the new sequence to load it into the timeline.

3. Choose Sequence > Settings

4. In the General tab, change the Aspect ratio to Custom 16:9



5. Make sure the sequence size (to the left of the Aspect Ratio pop-up 
menu) is set to 720 x 405.

6. Drag the edited sequence from the Browser into your new, 16:9 
sequence

7. It will come in pillar-boxed, because Final Cut always scales a larger 
image so that the entire image is visible when it is edited to a sequence 
smaller than the original image size.

8. Option+double-click the sequence you just edited into the timeline to 
load it into the Viewer (if you just double-click it, you'll open the original 
sequence for editing).

9. Go to the Motion tab and change the scale percentage from about 84% 
to 100%. Your image will zoom up to full resolution edge-to-edge, while 
retaining it's 16:9 shape.



10. Export and compress as you would any other video, just remember to 
choose an Anamorphic setting for Compressor to retain the 16:9 aspect 
ratio.
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Converting 16:9 to 4:3

Kristina Latour writes:

I'm doing a multi-cam editing job with two cameras - one of them was shot in 
widescreen format, and the other is in 4:3 format. My client wants the whole project to 
be in 4:3 format, so I adjusted the letterbox clips in the 'Scale' and 'Distort' in Motion, to 
match the other camera, and now the adjusted format is blurry and it's lost quality. 

My question is, is there a way to adjust to the 'non-widescreen aspect', without losing 
quality? If not, and I have to adjust the other way, to match the original letterbox quality, 
how do I do it so that it exactly matches? Thanks!

Larry replies: The easiest way to adjust your video is to use the Motion tab and crop the left and right 
edges. However, the total number of pixels in both 16:9 and 4:3 is the same; what's different is their 
shape. 4:3 pixels are tall and thin, while 16:9 pixels are short and fat. This means that it is EASY to get 
4:3 to look like 16:9 because you are removing pixels from the top and bottom. However, it is HARD to 
get 16:9 to look like 4:3 because you need to increase the size of your image to fill missing pixels at 
the top and bottom.

Anytime you scale an image more than 100%, your image quality will degrade.
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Making a Microphone Disappear

Boris Ersson writes:

I am editing my films about sailing in the northern waters of the Bay of Bothnia, and on a 
few tapes I have a problem: I put an extra microphone on top of the camera, and it has 
tilted down a little bit on some scenes, showing a black rounded edge in the upper part 
of the screen. I try to avoid scenes with that problem.

Is there a way to fix it? I talked to a friend who said that I could make the entire film to 
16x9 format with a letterbox (under Effects-video filter-matte-widescreen) I tried it and it 
worked. But a friend at TV told me that they don't approve of this because when people 
view the film on the new screens they enlarge the image - and the result is much worse 
quality.

Another editor saud that I could zoom in on the scenes with the problem and move the 
image a little bit up. Is that possible?

Larry replies: Boris, first if the mike is just in the shot, but outside of Action Safe (the outer of the two 
rectangles in the Canvas), I'd suggest just leaving it there. 

Or, you could crop the top of the frame to hide the make, but that would put a black bar at the top of 



your image. If it is outside Action safe, you'll probably be OK.

If the camera were stationery, you could try to composite a portion of the frame just to either side of 
the mike to cover the mike, for example, copy of patch of blue sky and paste it over the mike, but if the 
background or camera is moving this will look reasonably terrible.

You could paint it out using wireframe removal techniques, but that would require using different 
software, such as Adobe After Effects, Pinnacle's Commotion, or Autodesk's Combustion.

UPDATE - March 6

Tony Mournian writes:

In limited use, and if the mic is not too far down into the picture, can you also enlarge 
the image slightly, pushing the mic out of the picture, but not ending up with a black line 
at top or bottom of the picture?

Larry replies: This, too, would work. Generally, however, you can only zoom an image about 5% 
before the loss in image quality becomes visible to the average viewer (whomever that is...). 
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Removing Filters

Francis Chee writes:

Can you remove all of same type of filter at once from the entire timeline in FCP6?

For example, you have applied a De interlacing filter to all clips and now want to remove 
it entirely without having to delete/switch off filters in individual clips.

Larry replies: Sort of...

Select all the clips to which you want to remove the filter.

Select Edit > Remove attributes and check Filters.

http://www.adobe.com/products/aftereffects/?promoid=BPDDW
http://www.pinnaclesys.com/docloader_n.asp?templ=10142&doclink=/cc/trialdownload.html&product_id=110&Langue_ID=7
http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=5562397


This removes ALL the filters from the selected clip(s). However, you can't remove an individual filter 
when more than one filter is assigned to a clip, or clips.

UPDATE - March 6

Neal Davis writes:

I read the answer to Francis Chee asking about removing filters from an entire timeline. 
If all your clips have the same filters, you can remove the offending filter from one of the 
clips. First remove the filter from one of the clips by deleting it. Then highlight the clip 
and choose COPY from the edit menu. Highlight all the clips in the timeline and then 
choose PASTE ATTRIBUTES (option V). Check the Filters box and you're done. Again 
this only works if the Filters are the same throughout the timeline.

Bob Flood adds:

Neal forgot one important point: Filter attributes are cumulative so its possible to add 
copies of the same filter to clips. Because of this you need Remove All Filters from the 
clips before you paste. 

So the workflow would be thus:

First remove the filter from one of the clips by deleting it. Then highlight 
the clip and choose COPY from the edit menu. Highlight all the clips in 
the timeline and then choose REMOVE ATTRIBUTES and check the 
Filters box Then, choose PASTE ATTRIBUTES (option V). Check the 
Filters box and you're done. Again this only works if the Filters are the 
same throughout the timeline."

Larry replies: Very cool. Thanks. 

[ Go to Top. ] 

Editing Workflow for ProRes and HDV



Dean Schweinler, from Florida, writes:

Anyway I"m working on a big project that this past year had us on the road with our 
Canon XL-H1 shooting interviews in HDV.... I also have a Sony MVR-15u playback 
deck. The more I'm learning about ProRes 422, it sounds like it's the way to go when 
editing HDV. 

Would I need an AJA or a BlackMagic capture card? What do you suggest? I read 
through your newsletters and I'm not EXACTLY sure how to progress from here on how 
to load all these interviews into my Mac to start editing this monster. 

Larry replies: Dean, it depends. Prior to FCP 6.0.2, if you wanted real-time capture, you needed either 
the AJA IO HD attached to any Intel/Mac via a FireWire 800 port, or a Decklink Extreme card in a Mac 
Pro. Both of these solutions support real-time conversion of ProRes.

If, however, this hardware is not an option, you can convert HDV to ProRes once you've captured it, 
using either Compressor or the Batch Export function of Final Cut Pro. This is much more time-
consuming, but much cheaper.

The third option is to capture HDV and render using ProRes. This option is only available in Final Cut 
Studio 2 and only for HDV, XDCAM HD or XDCAM EX. The Rendering article earlier in this issue 
explains how to do this.

UPDATE - March 6

Matt Davis writes:

I can capture directly from Z1 HDV to ProRes 422 in FCP 6.0.2 without having to 
transcode, which has finally ended my naughty use of AIC over HDV for editing. The 
workflow is very similar (in that each shot is a separate file, and there's no log and 
capture, just suck everything in).

Use FCP's easy setup for HDV 1080i50 (for example), then in Audio/Video settings, 
switch the Capture preset to HDV-ProRes 422 standard or HQ and the performance 
feels like AIC on a two year old machine.

I hope this also works for the XL-H1.

Larry replies: Matt, thaniks for letting me know. 

[ Go to Top. ] 

Cable Limit for FireWire 800

Will Higgins writes:

I have acquired a 33' Firewire 800 cable and have done some testing. 33' is supposed 
to be the greatest distance before a repeater is required. I have captured entire reels of 
HD and standard from an HDR-HDC3 and rendered a half-hour long composite of two 
full HD clips. Additionally, I've done heavy load Finder testing - four 70 GB files copying 
to and from the drive simultaneously.

So far, not a single problem or sign of such.



Question: I am not a big FCP guy. I'm a good troubleshooter of it, but not a user in any 
sense. That in mind, is the testing that I've done sufficient or are there other, more hard 
drive intensive tests that you would recommend? 

Larry replies: I'm not a testing facility either, but my opinion is that if you can get it operating correctly 
and consistently, then you are probably fine. Thanks for letting me know about the cable limits of 
FireWire 800 - as a reminder to other readers, this is the TOTAL distance of all cables. The total 
distance of all cables can not exceed 33 feet.

[ Go to Top. ] 

Problems with Apple Support

Sharon Lawler writes:

About a month ago, I was experiencing a problem loading Final Cut and wrote you for 
advice. After confirming that I had already done all the steps you’d normally 
recommend, you suggested that I take advantage of my AppleCare plan.

Today, I called AppleCare. Of course, they asked what version of Final Cut I was 
running. When I told them I was running Final Cut 5.0.4, they responded, “Well, all of 
our screens here are running Final Cut 6.0, so we really can’t support users of Final Cut 
5.” I think this is outrageous! When I bought my new G5 and Final Cut 5.0 about a year 
and a half ago, Final Cut 6 wasn’t even out! And the AppleCare plan is a three year 
plan, so how dare they now say they don’t support me as a user just because I don’t 
have Final Cut 6!

It’s a shame that Apple appears to be [unable or unwilling to support older versions of 
their software. Microsoft supports versions up to eight years after release.]

Using the phrase "we can’t help you with that old version you’re running---upgrade and 
call us back" doesn't work when new versions continue to give people problems which 
is why I haven’t upgraded yet.

Larry replies: Sharon, thanks for writing. However, look at Ben's response below.

UPDATE - March 6

Ben Balser writes:

Here's my take on Apple Care and FCP. There is not "Apple Care for FCP". AppleCare 
covers your hardware, not software. And I could be wrong on this, but it is currently my 
understanding that Apple does have an annually renewable video production support 
program, although it is priced for those making a living off of video, not for the general 
user. I'd also suggest users find an on-line FCP forum "that they like" to go to before 
Apple when it comes to pro apps.

Larry replies: Ben, thanks for pointing this out. Microsoft is supporting its software, Apple is supporting 
its hardware. As always, I'm interested in hearing what other readers think.

[ Go to Top. ] 



Get Your FireStore Questions Answered Here

Ben Balser, head of the South Louisiana Final Cut Pro User Group, sent me the following:

For those of you using FireStore DTE's from Focus Enhancements, or just thinking 
about going tapeless with and "FS" unit, I've started a new forum. It was started as a 
supplement to my FS-100 user guide DVD, and soon to be released FS-4 Pro/HD user 
guide DVD, but is open to everyone using one of these units. It will provide unofficial 
tech support and social networking for FS users. Looking forward to seeing all my fellow 
FireStore users there!

[ Go to Top. ] 

Making Compressor Multi-processor Aware

http://firestore.ning.com writes:

I own a new 8-core mac. So far after all the reading online, I still can not find a way to 
use the 8-core in compressor to maximize the output time; how do I set this up via q-
master and compressor; please advise.

Larry replies: You use System Preference to create a Virtual Cluster and set the number of instances 
to 50% of your processors - in your case, 4.

Then, when you submit files you select "Virtual Cluster," and not "This Computer."

The screen shot above shows you how to configure the System Prefs - except your pull-down will 
show 8 instances, from which you select 4.

After that, it's automatic.

[ Go to Top. ] 

http://www.larryjordan.biz/nxltrs/www.slfcpug.org
http://firestore.ning.com/


Wrap-up

Well, that's about it for this month. For current news on what's happening in our industry, be sure to 
listen to the Digital Production BuZZ every week.

In the meantime, please continue sending me your comments and questions. I love hearing from you 
and enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry
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